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1.1 Инсталляция ActiveSync 

Для осуществления обмена данными между MoData2 и вашим ПК через 
последовательный интерфейс, необходимо инсталлировать на вашем 
персональном компьютере (ПК) программное обеспечение "ActiveSync" от 
Microsoft. 
Английский инсталляционный файл "msasync.exe" Вы найдёте на NaMobil -
диске в каталоге"ActiveSync\English". Самая актуальная версия ActiveSync 
от Microsoft предлагается в интернете для бесплатной загрузки, например, 
версия 3.7.1, по адресу: 
 
www.microsoft.com/windowsmobile/resources/downloads/pocketpc/activesync37.mspx 
 

 
 
После инсталляции ActiveSync и установки, так называемого, 
"Партнёрства", MoData2 будет работать как дополнительный дисковод к 
вашему ПК с  возможностью считывания и записи информации. При 
помощи ActiveSync Вы можете не только загружать данные с MoData2 и 
переносить их на MoData2, а также инсталлировать на MoData2 новое 
программное обеспечение. 
 
Примечание: 
 
Если ActiveSync исталлирован правильно, то на таск-меню компьютера 
внизу справа появится серая шайба. Включите MoData2 и только после  
включения соедините ПК и MoData2 трансфер-кабелем. При правильном 
соединении серая шайба на таск-меню станет зелёной.  
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1.2 Новая конфигурация компьютера МoData2 

В состоянии поставки при стандартном варианте MoData2 полностью 
сконфигурирован, так что прямо сразу после распаковки можно проводить 
измерения. 
 
Однако, приблизительно через 3 недели, если аккумулятор не заряжали, 
компьютер теряет свою конфигурацию и инсталлированное программное 
обеспечение. 
 
После полного разряда аккумулятора или жёсткого перезапуска (резет) 
(смотри раздел 1.5.2) в вашем распоряжении остается только собственная 
оперативная среда компьютера и офисс-программы. Дополнительно 
инсталлированное программное обеспечение (например, IntMobil) нужно 
инсталлировать заново.  
 
После полного разряда аккумулятора или жёсткого перезапуска 
необходимо выполнить следующие шаги : 
 

1. Произвести основную конфигурацию 
2. Освободить Windows-Desktop (рабочий стол) 
3. Сконфигурировать систему управления в ручном или в 

автоматическом режиме 
4. Инсталлировать дополнительное программное обеспечение 

(напр., IntMobil или NaMobil) 
 

CF-Карта 

MoData2-компьютер оснащён, так называемой, "Compact-Flash Karte" (CF- 
картой). На этой CF-карте могут находиться файлы и инсталляционные 
пакеты. При полном разряде аккумулятора или при жёстком перезапуске 
системы CF-карта сохраняет всю имеющуюся на ней информацию. 
 
В разделе 1.2.2: "Автоматическая конфигурация с CF-картой", описано, 
как при помощи CF-карты можно выполнить конфигурацию системы 
управления. 
 
В разделе 1.3.2 описано, как интсталлировать программное обеспечение 
"NaMobil" с инсталляционным пакетом "Namobil_30.cab" непосредственно 
с CF-карты. 
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1.2.1 Основная конфигурация 

Для того, чтобы зарядить аккумулятор и осуществить включение MoData2, 
необходимо подключить MoData2 к зарядному устройству. Включить 
MoData2 нажатием красной клавиши "Ein" (вверху, в середине клавиатуры) 
и ждать несколько секунд до появления на экране изображения. 
 
Для контроля процесса зарядки компьютера мигает индикатор зарядки и  
на экране появляется приветственная заставка Windows Setup: 
 

 
 
Для старта калибровки экрана нажать клавишу возврата <Enter> или 
нажать штифтом на сам экран. 

Калибровка экрана 

На экране появляется руководство по калибровке (Touchscreen): 
 

 
 
Внимательно прочитайте и следуйте дальнейшим указаниям по калибровке 
с помощью перекрестия или специального штифта. 
 

 
 

Калибровка экрана необходима для точного распознавания компьютером 
MoData2 места прикосновения штифтом на экране. 
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Установка мирового времени 

По окончании калибровки экрана появляется диалоговое окно "World 
Clock" с регистром "Home City": 

 

 
 

Выберите, например, город "Berlin" или другой город из ближайшего 
вашего окружения. 
 
Щёлкните штифтом на регистре "Date & Time" и выберите дату на 
календаре. 

 

 
 

Выставьте на левых часах актуальное время либо вращением минутной 
стрелки циферблата штифтом, либо впечатайте это время в окошко под 
часами при помощи клавиатуры MoData2. 
 
Для окончания ввода щёлкните на клавишу "Continue" справа внизу на 
экране. Актуальные дата, время и город введены. 
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Установка данных владельца 

Появляется следующая заставка "Owner Properties": 
 

 
 
Здесь можно задать имя владельца и другую контактную информацию. 
Если вы активируете окошко "Display Owner Identifikation", то при каждом 
включении MoData2 будет появляться эта информация.  
 
Щёлкните на клавишу "Continue" на экране справа внизу и закройте Setup 
щелчком на "Done".  
 
 

 
 
 

На экране появится  Windows-Desktop ("рабочий стол"): 
 

 
 
 

Так как символы "Tasks", "Internet Explorer", "Contacts", "Calendar",  
"My Documents" и "Inbox" на "рабочем столе" не используются и только 
занимают место на экране, то их можно стереть. 
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Замаркируйте выше названные символы, при нажатой клавише <Strg> 
нажимая поочерёдно на них штифтом. Затем отпустите <Strg>-клавишу. 
Держа  <Alt>-клавишу нажатой, щелкните на один из замаркированных 
символов. Рядом с выбранным символом на экране появится маленькое 
меню: 
 

 
 
Отпустите <Alt>-клавишу и щелкните на "Delete" (стереть). Компьютер 
запрашивает подтверждение о стирании символов. При нажатии клавиши 
"Yes" выбранные символы будут стёрты с "рабочего стола".  
 
На экране появится Windows-Desktop ("рабочий стол") без лишних 
символов: 
 

 
 
Для того, чтобы освободить место для новых символов, перенесите при 
помощи штифта символ  "My Handheld PC"  в левый нижний угол.  
 
Теперь Windows-Desktop ("рабочий стол") полностью очищен от лишних 
символов: 
 

 
 
 

MoData2-компьютер в основном сконфигурирован, осталось ещё сконфи-
гурировать систему управления, например, для подсветки дисплея и 
ActiveSync, а также инсталлировать дополнительные программы, 
(например, NaMobil или IntMоbil). 
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1.2.2 Автоматическая конфигурация с CF-картой 

При конфигурации системы управления компьютера MoData2 
Backup-файл "fex21_e.exe" уже инсталлирован на CF-карте и может быть 
запущен при  помощи "Windows-Explorer".  
 
Стартуйте "Windows Explorer": для этого щелкните Start -> Program Files 
-> Windows Explorer. 
 

 
 

Дважды щелкните на "Compact Flash". Покажутся файлы  и каталог  
CF-карты: 
 

 
 

Стартуйте конфигурацию с CF-карты при помощи двойного щелчка на 
самовыполняемый Backup-файл "FEX21_E". 
 
 
Покажется старт-диалог Backup-программы: 
 

 
 

Активируйте окно "Overwrite files that conflict with backup" и щелкните 
затем на "Extract"-клавишу. 
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Архив  будет раскрыт и при этом установки  компьютера переписаны с 
правильной конфигурацией: 
 

 
 
После развертки Backup-архива появляется приказ о необходимости 
"тёплого" старта, для того чтобы перенять изменения: 
 

 
 

Выполните "тёплый старт", как описано в главе 1.5.1.Теперь инсталлируйте 
ваше дополнительное программное обеспечение (напр., NaMobil или 
IntMobil 3.0). 
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1.2.3 Ручная конфигурация без CF-карты 

Если в MoData2-компьютере нет CF-карты или Вы не нашли 
конфигурационный файл "fex21_e.exe" на CF-карте, то конфигурация 
системы управления должна быть выполнена  вручную. 
Выберите систему управления: Start -> Settings -> Control Panel: 
 

 
 

Выполните следующие установки в системе управления: 
 
Power, регистр "Power Off" 
 

On battery power syspend after:  5 Minutes 
(Батарею отключить через: ) 

 Enable suspend while on external power: Выкл. (без галочки) 
(Режим готовности активировать:) 
 

 
 

fex21, регистр "Power" 
 
Enable charging (заряд возможен):  Вкл. (галочка) 
Allow suspend with AC adaptor connected 
(откл. не взирая на подключенное АС-зарядное устройство):  Выкл. (без галочки) 
Allow Charger Wakeup: Вкл. (галочка) 
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fex21, регистр: "APM" 
 
Use battery percent to determine status 
(информация о состоянии батареи): Вкл. 
Battery critical warning (информ. о критическом состоянии батареи при): 5 % 
Battery Low warning (информ. о низком заряде батареи при): 10% 
Ignore Battery Voltage Override (перезаряд батареи игнорировать): Выкл. 
 

 
 

 
 
fex21, регистр: "Comms" 

 
Port1 Main Connector  Вкл. 
Power Output  Выкл. 
Port2 Main Connector  Вкл. 
Power Output  Выкл. 
Enable ActiveSync over USB  Выкл. 

 

 
 
 
 
Options, регистр "View"        (через Control Panel->View->Options) 

 
Show all files (показать все файлы):  Вкл. 
Hide file extensions 
(расширение файлов не показывать):  Выкл. 
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1.3  Инсталляция NaMobil 3.0 

Для проведения повторных измерений прибором MoData2 на нём 
необходимо инсталлировать программное обеспечение NaMobil 3.0. 
 
Для этой цели в комплекте с NaMobil 3.0 высылается компактдиск с 
инсталляционным пакетом и программой Setup. 
 
"Namobil_30.cab" – это название инсталляционного пакета для повторных 
измерений. 
 
Если программное обеспечение было выслано вместе с MoData2, то на 
CF-карте, встроенной в MoData2-компьютере, находится защищённый от 
записи инсталляционный пакет. 
 
Исталляционный пакет на CF-карте может быть применён для срочной 
инсталляции программного обеспечения без подключения к персональному 
компьютеру (т. е. непосредственно в поле). 
 
Инсталляция с CF-карты описана в разделе 1.3.2. 
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1.3.1 Инсталляция NaMobil 3.0 с компактдиска (CD) 

Необходимым условием для инсталляции NaMobil 3.0 с CD является 
корректная инсталляция ActiveSync на вашем ПК, смотри раздел 1.1, и 
корректная конфигурация системы управления, смотри раздел 1.2.  
 
Соедините MoData2 с вашим ПК посредством трансфер-кабеля. 
 
Если ActiveSync не осуществляет связь  ПК с MoData2 автоматически, то 
проверьте выставленные параметры  ActiveSync на вашем ПК и запустите 
подключение в ручном режиме через MoData2 путём активирования 
приказа Start -> Programs -> Communication - > PC-Link. 
 
Для инсталляции программного обеспечения с CD достаточно одного 
"Guest-Connection". 
 
Для инсталляции NaMobil 3.0 необходимо стартовать файл  "Setup.exe", 
находящийся на СD в директории "NaMobil_30". 
 
На экране ПК появится изображение на английском языке, запрашивающее 
название директории для инсталляции программы: 
 

 
 

Примечание: 
Обратите внимание на то, чтобы на ПК в директрории "C:\Program 
Files\NaMobil" отсутствовала защищённая от записи версия 
"Namobil_30.cab ". В противном случае сотрите этот файл, так как при его 
наличии инсталляция прервётся с сообщением об ошибке. 
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Инсталляционный пакет будет вначале скопирован на ваш ПК в 
предложенную директорию (здесь: "C:\Program Files\NaMobil"), а затем 
переносится с ПК на MoData2, где и инсталлируется. Появляется вопрос о 
директории на MoData2-компьютере, где будет инсталлирована программа: 
 

 
 

Подтвердите стандарнтую директорию нажатием "Yes"-клавиши. 
 
ActiveSync переносит инсталляционный пакет "Namobil_30.cab" к MoData2 
и показывает процесс инсталляции на экране ПК: 
 

 
 
 

После переноса инсталляционного пакета и автоматической инсталляции 
на экране прибора MoData2 появляется требование о необходимости 
проверки дополнительных шагов для данной инсталляции: 

 

 
 

Щёлкните на клавишу "OK". На Windows-Desktop (рабочем столе) 
появляются обе инсталлированные программы "NaMobil 3.0" и 
"Multimeter": 
 

 
 

 
Инсталляция NaMobil 3.0 закончена. 
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1.3.2 Исталляция NaMobil 3.0 с CF-карты 

При помощи инсталляционного пакета "Namobil_30.cab", находящегося на 
CF-карте, можно инсталлировать программное обеспечение NaMobil 3.0 
непосредственно на MoData2-компьютере без подключения к ПК.  
 
Для инсталляции с CF-карты необходимо с помощью Windows-Explorer 
вызвать директорию с именем "Compact Flash": 
 

 
 
 
Стартуйте инсталляцию с помощью файла "Namobil_30.cab". 
 
 
Появляется запрос о желаемом каталоге для инсталляции: 
 

 
 
 
Подтвердите предложенный каталог для инсталляции " NaMobil ". 
 
MoData2-компьютер инсталлирует программное обеспечение NaMobil 3.0 в 
каталоге "Program Files\ NaMobil". 
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После успешного завершения инсталляции на дисплее появляется 
соответствующее сообщение: 
 

 
 

Щёлкните на "OK"-клавишу и закройте Windows-Explorer. 
 
 
На Windows-Desktop  появляются обе инсталлированные программы 
"NaMobil 3.0" и "Multimeter": 
 

 
 
 
Инсталляция NaMobil 3.0 закончена. 
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1.4 Обновление программы из интернета  
(Software-Update) 

С целью гарантированной работы компьютера MoData2 с самой актуальной 
версией, вам необходимо найти эту версию в инсталляционном пакете 
"NaMobil_30.cab"  в интернете на страничке фирмы Weilekes Elektronik по 
адресу: 
 

www.weilekes.de/English/download/index.htm 
 
или непосредственно из файла по адресу: 
 

www.weilekes.de/Download/Deutsch/Namobil_30.zip 
 
 
После загрузки файла "Namobil_30.zip" необходимо развернуть 
находящийся в нём файл "Namobil_30.cab" (например, с помощью 
программы "WinZip") и скопировать его на CF-карту компьютера МoData2.  
 
После копирования файла "Namobil_30.cab" на CF-карту выполните шаги 
согласно разделу 1.3.2: "Исталляция NaMobil 3.0 с CF-карты". 
 
 
Примечание: 
 
Вы можете также описать CF-карту через Windows-Explorer вашего ПК при 
помощи  активирования ActiveSync (зелёная шайба на таск-меню должна 
стать видимой). При этом не требуется демонтаж CF-карты из компьютера 
MoData2. 
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1.5 Выполнение резета 

С целью возврата компьютера MoData2 в определённое состояние после 
срыва его работы или сбоя, у компьютера MoData2 имеется два возможных 
вида резета (перезагрузки): "тёплый" старт и "холодный" старт. 

1.5.1 "Тёплый" старт (программная перезагрузка) 

При блокировке клавиатуры или срыве программы компьютер MoData2 
может быть приведён в первоначальное рабочее состояние при помощи 
"тёплого"старта. 
 
Для выполнения "тёплого"старта необходимо при включенном компьютере 
одновременно нажать две клавиши регулирования контрастности дисплея, 
находящиеся слева от красной Ein-клавиши (клавиша включения). Через 
несколько секунд дисплей погаснет. После чего отпустите обе клавиши. 
 
fex21 выполняет "тёплый"старт. На короткое время на дисплее появится 
символ "Husky fex21", а затем обычный Windows-Desktop. 

1.5.2 "Холодный" старт (жёсткая перезагрузка) 

При холодном старте на компьютере MoData2 стираются все установки, 
данные и дополнительно инсталлированные программы. При этом  
компьютер MoData2 приводится в исходное состояние, соответствующее 
состоянию поставки. 
 
Для выполнения "холодного"старта необходимо при включенном 
компьютере одновременно нажать две клавиши регулирования 
контрастности дисплея (слева, рядом с красной Ein-клавишей), красную 
Ein-клавишу и (+)–клавишу освещённости дисплея и держать в нажатом 
состоянии не менее 6 секунд. После чего все четыре клавиши можно 
отпустить и включить компьютер при помощи  красной Ein-клавиши. 
 
fex21 выполняет "холодный" старт. На короткое время на дисплее появится 
символ "Husky fex21", а затем указание на выполнение Windows-Setup. 
 
Следующие шаги выполняйте в соответствии с разделом 1.2: "Новая ". 
После чего может быть выполнена инсталляция программы в соответствии 
с разделом 1.3. 
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2. Синхронизация 
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2.1 Mеню "Sync" 

При помощи меню "Sync" прибор MoData2 может быть синхронизирован с 
тактом переключений катоднозащищённого трубопровода. 
 

 
 
Рекомендуется выполнять синхронизацию в каждый новый день измерений 
перед  выполнением первого измерения. 
 
Встроенные часы компьютера MoData2 гарантируют синхронный ход в 
течение 24 часов с точностью ± 0,25 сек. при температуре окружающего 
воздуха от +10°C до +30°C. Экстремальные температуры могут привести к 
увеличению погрешности. 
 
 
Программа NaMobil 3.0 предлагает три способа синхронизации: 
 

 Автоматическая синхронизация  
 Ручная синхронизация 
 GPS-синхронизация 
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2.1.1 Автоматическая синхронизация 

После выбора меню "Sync" -> "Extern" на дисплее появляется балочный 
график состояния такта внутренних часов компьютера MoData2: 
 

 
 

На примере компьютер MoData2 показывает такт переключений 12 / 3 к 
моменту времени 8 сек. после выключения.  
 
Для автоматической синхронизации необходимо подключить кабель 
"Externen Synchronisierkabel", входящий в комплект поставки MoData2, к 
5-полюсному разъёму "Ext. Sync / Relay" компьютера MoData2. Второй 
конец кабеля соединяется с потенциальносвободным контактом прибора 
переключения (напр., Teletakt-N или MiniTrans). При помощи этого кабеля 
MoData2 может самостоятельно распознать планку переключений и в 
соответствии с ней синхронизировать свои внутренние часы. 
 
Требуемый такт переключений выбирается нажатием клавиши <C> (для 
такта) компьютера или при помощи штифта непосредственно на дисплее: 
 

 
 
Синхронизация начинается после нажатия "External"-бутона или клавиши 
<E>: 

 
 

MoData2 ожидает переключения внешнего контакта. 
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После выполнения синхронизации на дисплее появляется подтверждение: 
 

 
 

Нажатием "Finish", клавиш <F> или <Esc> синхронизация завершается. 
 
 
 
Внимание: 
 
При подключении компьютера MoData2 к внешнему прибору переключений 
необходимо исключить подсоединение к потенциальносвободным 
контактам других источников напряжения.  В противном случае вход 
автоматической синхронизации MoData2 может быть выведен из строя.  
 
Не допускается подключение кабеля к находящейся в такте розетке 
230В приборов Teletakt-N или Syntakt. 
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2.1.2 Ручная синхронизация 

Ручная синхронизация выполняется при отсутствии возможности 
проведения автоматической или GPS-синхронизации. 
 
После выбора меню "Sync" -> "Manual" на дисплее появляется балочный 
график состояния такта внутренних часов компьютера MoData2: 
 

 
 

 
На примере компьютер MoData2 показывает такт переключений 12 / 3 к 
моменту времени 5 сек. после выключения. 
 
 
Требуемый такт переключений выбирается нажатием клавиши <C> (для 
такта) компьютера или при помощи штифта непосредственно на дисплее: 
 

 
 

 
Для ручной синхронизации используйте мультиметр, с которого можно 
легко считать значение потенциала и увидеть перемещающуюся планку 
переключения. В момент переключения (изменение от потенциала 
включения к потенциалу выключения) нажмите клавишу <M> или <Enter>. 
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После выполнения синхронизации на дисплее появляется подтверждение: 
 

 
 
Нажатием "Finish", клавиш <F> или <Esc> ручная синхронизация 
завершается. 
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2.1.3 GPS-синхронизация 

GPS-синхронизация позволяет синхронизировать MoData2 без 
подключения её к потенциальносвободным контактам. С помощью GPS-
антенны можно выполнить новую синхронизацию компьютера на открытой 
местности  в любое время без подключения к катодной станции. 
 

 
MoData2 с подключенной GPS-антенной 

 
Перед началом синхронизации необходимо подключить разъёмы GPS-
антенны (заказывается дополнительно) к MoData2: цилиндрический разъём 
к гнезду "Charge / GPS", а 9-полюсный "D-Sub"-разъём к гнеэду "PC / GPS". 
 
После выбора меню "Sync" -> "GPS" на дисплее появляется балочный 
график актуального состояния такта внутренних часов компьютера 
MoData2 и статуса GPS-антенны: 
 

 
 

 
GPS-антенна, закреплённая на стальной ручке MoData2, должна быть 
выставлена так, чтобы обеспечить по возможности максимально 
свободный доступ к небу/горизонту. Не допускается перекрытие 
пространства от антенны к небу/горизонту постройками или другими 
объектами. 
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Требуемый такт переключений выбирается нажатием клавиши <C> (для 
такта) компьютера или при помощи штифта непосредственно на дисплее: 
 

 
 
 
"GPS"-бутон деактивирован до тех пор, пока GPS-антенна не приняла 
актуальное время. При хорошем приёме MoData2 покажет актуальное 
время через 20 сек., и бутон "GPS" переходит в активное состояние: 
 

 
 

 
Показываемое время является, так называемым, UTC-временем. По 
отношению ко времени в Германии UTC-время имеет разницу  (–2) часа в 
летнее время и (–1) час в зимнее. Так как для гарантии синхронизированного 
такта по отношению к источнику такта (напр., DCF-антенна в Teletakt-N или 
MiniTrans) используются только секунды, то часовая разница не играет роли. 
 
При хорошем приёме GPS-координат в течение следующих 20 сек. - 5 
минут  MoData2 покажет наряду со временем и GPS-координаты в, так 
называемой, WGS-84-системе: долготу и широту. Одновременно 
высвечивается количество "пойманных" сателлитов: 

 

 
 
Для определения долготы и широты требуются минимум 3 сателлита. Для 
получения более точных координат требуются 4 сателлита или более. 
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Для синхронизации MoData2 с помощью GPS-антенны нажмите клавишу 
<G>. В этот момент MoData2 автоматически синхронизируется с принятым 
GPS-временем и подтверждает синхронизацию: 
 

 
 
Внимание: 
Для внесения в компьютер MoData2 только GPS-координат без 
синхронизации его внутренних часов с UTC-временем сателлитов (в 
случае применения в качестве источника такта приборов не 
синхронизирующихся с помощью антеннны DCF-77, например, 
SYNTAKT) клавишу "G" не нажимать и закончить синхронизацию,  
ниже приведённым действием.     
 
 
 
Нажатием "Finish", клавиш <F> или <Esc> диалог с GPS-синхронизацией 
завершается. 
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3. Периодические измерения 
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3.1 Меню "File" (Файл) 

Меню "File" позволяет создать новый ряд измерений, открывать 
существующие маски/ряды измерений и архивировать данные измерений 
при обработке ряда измерений. 
 

 

3.2 Meню: "File" -> "New" (Новый) 

Меню "File" -> "New" позволяет создать новый файл для трубопровода, на 
котором планируется проведение периодических измерений и для которого 
в MoData2 ещё не были созданы маcka или ряд измерений. 
 
На экране появляется диалоговое окно для введения основных данных: 
 

 
 
После введения основных данных появляется возможность выбора 
контрольно-измерительных колонок (далее по тексту "КИК"). Так как введён 
новый трубопровод, то появляется только один пустой КИК.  
 
При помощи меню "Edit" -> "Insert", "Edit" и "Delete" (Обработать -> Ввести, 
Изменить и Удалить) можно ввести новые КИК-и, изменить их или удалить. 
Более подробно смотри в главе 3.11. 
 
После внесения данных измерений на новом трубопроводе необходимо 
запомнить данные под новым именем, используя меню "File" -> "Save as". 
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3.3 Меню: "Datei" -> "Open" (Открыть) 

Для выполнения периодических измерений необходимо открыть 
существующий ряд измерений при помощи меню "File" -> "Open". 
Появляется диалоговое окно "Load File" (файл открыть): 
 

 
 

Коснитесь штифтом нужного файла и нажмите на "OK". 
 
При отсутствии штифта нажмите клавишу <Tab> клавиатуры и держите её 
нажатой до тех пор, пока верхний файл не замаркируется. Затем клавишей 
<Cursor Down>-(стрелка вниз) выбрать необходимый файл.  
 

 
 

После нажатия <Return>-клавиши выбранный файл будет загружен.  
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3.3.1 Выбор контрольно-измерительной колонки 

После загрузки файла появляется таблица КИК-ов: 
 

 
 
Непосредственно под строкой меню видны основные данные ряда 
измерений (имя файла, дата, название трубопровода и номер). 
 
Звёздочкой перед номером КИК-а обозначаются те КИК-и, на которых 
измерения были выполнены. 

Перемещение курсора 

При помощи клавиш <стрелка вверх> или <стрелка вниз> может быть 
отмаркирована любая другая строка. 
При помощи клавиши <Return> или щелчком на  "Measure" 
подтверждается выбор, и на экране появляются значения измерений на 
КИК-е.  
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3.3.2 Меню измерений 

После выбора КИК-а (при помощи щелчка на бутон "Measure" или 
нажатием клавиши <Return>) на экране появляются все данные маски, 
относящиеся к этому КИК-у. Таким образом, в окошке видны данные маски 
(номер, тип, место расположения КИК-а и т.д.) и значения измерений: 
 

 
 
С целью выбора другого КИК-а можно выйти из меню измерений при 
помощи нажатия на клавишу <Esc> или щелчком на бутон "OK".  

3.3.3 Выбор типа измерений 

Типы измерений выбираются нажатием соответствующего бутона: "Pot", 
"Vtg", "Mic", "Curr" и "Res": 
  
"Pot" :  Потенциал Включения и Выключения трубопровода 
 
"Vtg":  Потенциал чужого трубопровода, потенциал защитного кожуха,  
  потенциал заземлителя или выходное напряжение выпрямителя  
  катодной станции  
 
"Mic": Измерение тока на КИК-е измерения тока или на внешнем шунте 
 
"Curr": Измерение тока на встроенном высокоомном шунте (100 mA – 30 A) 
 или выбор одного из внутренних диапазонов измерений тока  
  (10 mA, 100 mA)  
 
"Res": 2- или 4-полюсное измерение сопротивления на фланце  
  или защитном кожухе 
 
Для каждого типа измерений в протоколе измерений имеются два столбца. 
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3.4 Тип измерений: "Potential" (Потенциал) 

Тип измереиний "Potential" служит для измерений потенциалов включения 
или выключения на трубопроводе. 
 
Для измерения потенциала клемма КИК-а соединяется с каналом А 
многофункционального преобразователя MoData2, а клемма "Масса" - с 
электродом сравнения. 
 

 
 

Схема подключения для типа измерений "Potential" 
 

  
При каждом такте NaMobil измеряет как потенциалы включения и 
выключения, так и переменное напряжение в период включения, и 
показывает значения измерений на экране в виде таблицы.   
 
Значения включения и выключения измеряются за 1 сек. до и, 
соответсвенно, 1 сек. после планки переключения.  
 
При помощи нажатия клавиши программа NaMobil30 может измерять 
только потенциалы включения. 
 
Кроме того, имеется возможность выбора формирования средних значений 
параметров включения и выключения, с тем, чтобы выровнять сильно 
колеблющиеся значения  при наличии блуждающих токов. 
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Показ фазы такта 

Время такта слева на экране соответствует количеству секунд после 
последней планки переключения. Сразу после планки переключения отсчёт 
начинается с цифры "0". 
 

 
 

Показ актуальных значений измеряемых величин 

В столбце "Aktuell" находятся значения постоянного (DC)  
и переменного (AC) напряжения, приложенных в данный момент  
к измерительному входу "A" компьютера MoData2. 
 
Эти значения актуализируются каждую секунду и позволяют распознать 
наличие, например, блуждающих токов.  

3.4.1 Выбор между измерением включения 
выключения  

Если на экране появился бутон "On+Off", то измеряются значения 
включения и выключения. 
 
Щелчком на этот бутон или нажатием клавиши <O> текст в бутоне 
поменяется на "only On", и измеряться будут только параметры включения. 
 
Повторным щелчком на этот бутон или повторным нажатием клавиши <O> 
текст в бутоне поменяется на "On+Off", и измеряться будут снова 
параметры включения и выключения. 
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3.4.2 Расчёт среднего значения 

Щелчком на бутон "Single" или нажатием клавиши <S> NaMobil30 
переходит к расчёту среднего значения. Надпись на бутоне изменяется на 
"Median" и обозначает, таким образом, переход к расчёту средних 
значений.  
 
При расчёте средних значений NaMobil30 измеряет параметр включения 
всегда за одну секунду до момента отключения и параметр выключения 
через одну секунду после момента отключения защитного тока. Эти 
значения прибавляются по отдельности к предыдущим параметрам 
включения и выключения. Затем NaMobil30 делит полученные результаты 
параметров включения и выключения на число замеров. Расчитанные 
значения параметров фаз включения и выключения показываются как 
средние значения: 
 

 
 
 
Количество замеров, из которых NaMobil30 сформировала средние 
значения, показаны над бутоном "Median" в виде числа. 
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3.5 Тип измерений: "Voltage" (Напряжение) 

Тип измерений "Voltage" служит для измерения напряжений, которые не 
могут быть отнесены к собственному потенциалу трубопровода.  
 
С помощью типа измерений "Voltage" измеряются , например, потенциал 
чужого трубопровода, потенциал защитного кожуха, потенциал заземления 
или выходное напряжение выпрямителя катодной станции. 
 
При типе измерений "Voltage", как и при типе измерений "Potential" клемма 
КИК-а соединяется с каналом А многофункционального преобразователя 
MoData2, а клемма "Масса" - с электродом сравнения:   
 

 
 

Схема подключения для типа измерений: "Voltage" 
 
 

 
Обслуживание и процесс измерения при типе измерений "Voltage" 
аналогичны принципу обслуживания и процессу измерения при типе 
измерений "Potential". 
 
Отличие состоит лишь в сохранении измеренных значений. Все 
измеренные значения при типе измерения "Spannung" NaMobil запоминает 
в столбце "Voltage", а не в столбце "Potential". 
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3.6 Тип измерений: "Current" (Ток) 

Тип измерений "Current" служит для непосредственного измерения тока 
через один из встроенных шунтов. Он позволяет измерять, например, ток, 
протекающий через фланец, или ток на отводе трубопровода. 
 
Для исключения больших падений напряжения при измерении тока в 
диапазоне измерений, менее 100 mA, в MoData2 встроены два низкоомных 
шунта  3 Ω и 10 Ω. 
 
Электрический самовосстанавливаемый 100 mA-предохранитель  
защищает электронные компоненты MoData2 при измерении тока. 
 
Для измерения токов более 100 mA рекомендуется выполнять измерения с 
использованием встроенного шунта (10 Ω), имеющего свой измерительный 
контакт с надписью "30A". На практике токи, выше 50 миллиампер, 
необходимо было бы измерять при помощи этого шунта.  
 

 
 

Измерение тока до 0,1 Aмпера 
 

 
 

Измерение тока от 0,05 Aмпер до 30,00 Aмпер 
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3.6.1 Проведение измерений тока 

После выполнения подготовительных операций для измерения тока (выбор 
внешнего или встроенного шунта) NaMobil показывает на экране таблицу 
измерения тока: 
 

 
 
 
Назначение бутонов и функций меню такие же, как и при типе измерений 
потенциала: щелчком на бутон "On+Off" или нажатием клавиши <O> 
измерения тока переключаются на измерения только тока включения. При 
стандартной установке NaMobil30  измеряет токи включения и выключения.  

Изменение диапазона измерений тока 

Щелчком на бутон "Change" или нажатием клавиши <C> можно изменить 
диапазон измерения тока. 
 
Примечание: обратите внимание на необходимость переключения 
измерительного кабеля при переходе от диапазона измерений "10mA" или 
"100mA" к диапазону "30A" и обратно. 
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3.7 Тип измерений: "Micro" (Микро) 

Тип измерений "Micro" позволяет измерять напряжения в микровольтовом 
диапазоне. Например, для определения величины защитного тока на 
участке трубопровода, измеряется падение напряжения на КИК-е тока с 
целью последующего расчёта тока с использованием известного 
сопротивления трубопровода.  
 

 
 

Схема подключения для типа измерений "Micro" 
 
Микровольтовое измерение производится с точностью 1 µV в диапазоне 
измерений ± 80 mV. При более высоких измеряемых напряжениях 
NaMobil30 показывает на экране пергрузку. При этом измерительный вход 
микровольтового измерения не выходит из строя. 
 
Для измерения тока трубопровода рекомендуется предварительно внести 
сопротивление участка трубопровода в маску. В этом случае NaMobil 30 
рассчитывает фактический ток уже во время микровольтового измерения. 

 
Калибровка нуля 
 
Для получения оптимальной точности при измерении напряжения в 
микровольтовом диапазоне рекомендуется выполнять калибровку нуля 
перед каждым измерением.  
 
Для чего необходимо соединить измерительный вход и клемму "Масса" 
коротким измерительным кабелем. При помощи функции: "Zero" или 
нажатием клавиши <Z> NaMobil30 выполняет калибровку нуля 
автоматически. 
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3.7.1 Проведение микровольтового измерения 

После выполнения подготовительных операций для микровольтового 
измерения NaMobil показывает на экране таблицу измерения тока в 
микровольтовом диапазоне: 
 

 
 
 
Назначение бутонов и функций меню такие же, как и при типе измерений 
потенциала:  
 
Щелчком на бутон "On+Off" или нажатием клавиши <O> микровольтовое 
измерение переключаются на измерения только параметров включения. 
При стандартной установке NaMobil30  измеряет параметры включения и 
выключения. 
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3.8 Тип измерений: "Resistance" (Сопротивление) 

Для измерения сопротивлений (например, изолирующего фланца или 
защитного патрона) MoData2 предлагает возможность двух- или 
четырёхполюсного измерения сопротивления методом "переменного 
напряжения". MoData2 работает с частотой 128 Hz и в пределах измерения 
сопротивления от 0,01 Ω до 800 KΩ. 
 
Для достижения оптимальной точности измерения сопротивлений, 
величина которых менее 5 Ω, используется 4-полюсное подключение. 
 

 
 

Схема подключения при 2-полюсном измерении сопротивления 
 
 
 

 
 

Схема подключения при 4-полюсном измерении сопротивления 
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3.8.1 Измерение сопротивления 

После выполнения подготовительных операций для измерения 
сопротивления NaMobil показывает на экране таблицу измерения 
сопротивления: 
 

 
 
Назначение бутонов и функций меню такие же, как и при предыдущем типе 
измерений:  
 
Щелчком на бутон "Change" или нажатием клавиши <C> можно 
переключаться с 4-полюсного измерения сопротивления на 2-полюсное и 
наоборот. Выбранный вид измерения высвечивается на экране над 
бутоном "Change". 
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3.9 Ввод текста 

Нажатием на бутон "Text" в измерительном меню или клавиши <T> можно 
вызвать диалоговое окно для ввода текста: 
 

 
 

Длина текста не должна превышать 20 знаков. 
 
 

3.10 Ввод вручную 

Двойным нажатием в меню на соответствующее поле с измеренной 
величиной предоставляется возможность введения значений 
сопротивлений вручную: 
 

 
 

Значение измерения вводится при помощи цифровых клавиш клавиатуры. 
Ввод значения подтверждается нажатием <Return>. 
 
Двойное нажатие служит для ручного ввода только в полях со значением 
сопротивления. Основные данные маски можно изменить лишь в 
соответствии с описанием в разделе 3.11.1: "Обработка основных данных". 
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3.11 Mеню "Edit" (Обработка) 

При помощи меню "Edit" могут быть изменены основные данные маски 
ряда измерений, а также введены дополнителные КИК-и, или изменены, 
или стёрты некоторые из них.  
 

 
 

3.11.1 Обработка основных данных 

При помощи меню "Edit" -> "Head" могут быть изменены основные данные 
трубопровода, введённые в соответствии с разделом 3.2: 
 

 
 

Нажатием клавиши <Return> осуществляется переход от одного поля 
текста к другому.  
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3.11.2 Ввод КИК-а 

При помощи меню "Edit" -> "Insert" вводится новая строка для нового КИК-
а. Причём вводится она после отмаркированной строки в перечне КИК-ов. 
Для ввода соответствующих данных для нового КИК-а (например, номер, 
тип и т. д.) NaMobil предоставляет маску ввода: 
 

 
 
Нажатием клавиши <Return> осуществляется переход от одного поля 
текста маски к другому.  

 

3.11.3 Изменение КИК-а 

При помощи меню "Edit" -> "Edit" (изменить) могут быть изменены данные 
КИК-а например, номер, тип и т. д.). NaMobil предоставляет маску ввода, 
как описано в предыдущем разделе 3.11.2: "Ввод КИК-а". 

 

3.11.4 Удалить КИК 

При помощи меню "Edit" -> "Delete" (удалить) в таблице КИК-ов может 
быть стёрт ненужный контрольно-измерительный пункт. 
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4. Аккумуляторы и их зарядка 
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4.1 Зарядка аккумуляторов 

 
Литиевые аккумуляторы компьютера MoData2 и свинцовые аккумуляторы 
измерительного интерфейса MoData2 заряжаются одновременно через  
4-полюсный цилиндрический разъём. Зарядное гнездо, расположенное на 
правой стороне компьютера MoData2, обозначено надписью 
"Charge / GPS". 
 
Для зарядки используйте только зарядное устройство, входящее в 
комплект поставки с вашей MoData2, или соответствующее 12В зарядное 
устройство аккумулятора автомобиля. 

4.1.1  Особенности зарядки аккумулятора 
компьютера MoData2 

Аккумулятор компьютера MoData2 полностью заряжен через 3 часа.  
 
Внимание: при зарядке аккумулятора компьютер MoData2 должен быть 
включен! 
 
Состояние заряда аккумулятора компьютера  MoData2 во время зарядки 
показывается оранжевым светодиодом, расположенным справа внизу на 
корпусе MoData2. Во время зарядки этот светодиод мигает равномерно. По 
окончании процесса зарядки светодиод горит постоянно. 
 
Неравномерное мигание светодиода сигнализирует о помехах при заряде. 
В этом случае обращайтесь к изготовителю. 
 
Внимание: 
 
Аккумулятор компьютера MoData2 не зарядится, если компьютер выключен 
или находится в состоянии "Standbymodus". 
 
Убедитесь в том, что установки в системе управления для обеспечения 
питанием выполнены в соответствии с главой 1.2.3: "Ручная конфигурация 
без CF-карты". 
 
Если эти установки выполнены неправильно, то компьютер MoData2 при 
подключенном зарядном устройстве самостоятельно не включается или 
через короткое время снова выключается. В обоих случаях зарядка 
аккумулятора компьютера MoData2 не происходит. 
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4.1.2 Особенности зарядки аккумулятора измерит. 
интерфейса MoData2 

Свинцовый аккумулятор MoData2-интерфейса полностью заряжается через 
14 часов. Но уже после 6 часов зарядки заряд составляет около 70% 
ёмкости.  

"Зелёный/красный"-светодиод заряда  

Зарядка свинцового аккумулятора контролируется светящимся 
"зелёно/красным"-светодиодом, расположенным рядом с гнездом 
"Charge / GPS". 
 
При выключенном MoData2-интерфейсе во время зарядки светодиод 
светится красным цветом и гасится при подключенном зарядном 
устройстве, если свинцовый аккумулятор заряжен 100%.  
 
Если аккумулятор не заряжается, то при включённом MoData2-интерфейсе 
светодиод горит зелёным цветом. Если зарядное устройство подключено, 
то светодиод горит оранжевым цветом. 
 
 
 
Примечание: 
 
При включённом MoData2-интерфейсе (напр., во время измерения 
напряжения) и подключенном зарядном устройстве происходит только 
поддержка имеющегося заряда литиевого аккумулятора MoData2 без его 
дополнительной подзарядки. 
 
Для зарядки свинцового аккумулятора необходимо закончить все 
программы, применяемые MoData2 измерительным интерфейсом (напр.,  
"NaMobil 3.0" или "IntMobil 3.0). 
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4.2 Aвтоматический контроль состояния 
аккумуляторов 

Состояние заряда литиевого и свинцового аккумуляторов показывается на 
дисплее во время работы программ "IntMobil 3.0" и "NaMobil 3.0": 
 
Пример: 
 

  
 
В примере отражается состояние аккумуляторов: 50% для литиевого 
(Н)usky аккумулятора и 97% для свинцового (М)oData2 

4.3 Ручной контроль состояния аккумуляторов 

Литиевый аккумулятор компьютера MoData2 может быть  
проконтролирован в ручном режиме с помощью меню  "Start" -> 
"Settings" -> "Control Panel" -> "Power". 
 
Ёмкость аккумулятора отражается в строке "Percentage of power left in main 
batteries": 
 

 
 
В примере остаточная ёмкость литиевого аккумулятора составляет 67%. 
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4.4 Потребляемый ток и время работы 

MoData2-компьютер 

Для компьютера МоData2 применяется литиевый аккумулятор  
7.4 V / 1000 mAчас. 
 
Среднее потребление тока компьютером MoData2 во включённом 
состоянии составляет, примерно, 100 mА, а в выключенном состоянии для 
сохранения данных, примерно, 2 mА. 

MoData2-измерительный интерфейс 

В измерительный интерфейс прибора MoData2 встроен свинцовый 
аккумулятор 6 V / 1300mAчас. 
 
Потребление тока измерительным интерфейсом изменяется от 75 mA при 
измерении напряжения до 130 mA при измерениии сопротивления. 
 
При работе GPS-антенны (заказывается отдельно) дополнительно 
потребляются 75 mA (для антенны типа: Holux 210) или 150 mA (для 
антенны типа: Fortuna U2). 

Беспрерывное время работы 

Среднее время беспрерывной работы прибора MoData2 составляет около 
10 часов, в зависимости от вида измерений и окружающей температуры.  
 
Минимальное время разрядки аккумулятора составляет 5 часов при 
постоянном измерении сопротивлений и подключенной GPS-антенне, 
независимо от того, находится ли антенна в активном состоянии или нет.  
 
Поэтому для увеличения времени работы аккумулятора при измерении 
сопротивления рекомендуется GPS-антенну не подключать. 
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5. Tехнические данные 
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5.1 MoData2 компьютер  

Tип:   Itronix fex21 

Корпус:    Ударостойкий пластик 

Размеры:  190 x 155 x 37 мм (Д x Ш x В) 

Вес:   800 г 

Степень защиты: IP 65 

Дисплей:  6.5", 16 ступеней, с подсветкой 
   640 x 240 пунктов, Touch-Screen 

Клавиатура:  Светящаяся, мембранная, водонепроницаемая  

Операционная система:  Windows Handheld PC 2000 

Процессор:  Toshiba 129 MГц 

Память:   32 MByte 

ПЗУ (ROM):  32 MByte 

Интерфейсы:  2 x 9 полюсов последовательный 
   инфракрасный 

Модем:   V34 аналоговый (встроен) 

Источник питания: литиевый аккумулятор, прим., 10ч. работы 

Диапазон рабочих  
температур:  -10°C до 50 °C 

Дополнительное 
оснащение:  Compact-Flash Karte (CF-карта) 64 MB (встроена) 
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5.2 MoData2 многофункциональный преобразователь 

Корпус: пластик 

Размер: 290 x 260 x 70 мм (Д x Ш x В) 

Вес: 2,25 кг (включая MoData2-компьютер) 

 7,80 кг (в комплекте с чемоданом) 

Интерфейс: 2 x 9 полюсов последовательный 
  12 V клемма для подзарядки  
  с гальванической развязкой) 
 Вход для подключения кабелей синхронизации и 
  реле  
Питание: Свинцовый аккумулятор 6 V / 1.3 Ачас, прим., 10ч.  
  работы 

Оснащение: MoData2, включая Itronix fex21 

 Штифт для управления с дисплея  
 Внешнее зарядное устройство 230 V 
 Кабель синхронизации 
 Tрансферкабель 
 Инструкция по эксплуатации 

Принадлежности  
(опция): Чемодан для переноски 
 Переносной ремень "Sprint" для сплошных 
  измерений 
 Переносной ремень "Marathon" для интенсивных  
  измерений 
 Внешнее зарядное устройство для заряда от  
  автомобильной батареи 12 V  
 GPS-антенна со встроенным приёмником 
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5.3 Пределы и точность измерений 

В ниже следующих таблицах приведены пределы измерений, 
разрешающая способность и максимальные погрешности измерений. 
 

5.3.1 Измерение напряжения постоянного тока 
(Канал A, B и C) 

Входное сопротивление:  > 10 MΩ 
 
Уровень подавления помех по переменному напряжению: 
       16,6 Гц  /   60 dB     (Фактор 1.000) 
     50,0 Гц  / 100 dB     (Фактор 100.000) 
 

Предел 
измерения

Разрешающая 
способность Макс. погрешность 

±     1 Volt 0.1 mV ± 0.5 %   ± 0.5 mV 

±   10 Volt 1 mV ± 0.5 %      ± 5 mV 

± 100 Volt 10 mV ± 0.5 %    ± 10 mV 
При неодновременном замере по 3-м каналам, разность времени между  
каналами < 100 ms 
 
 

Предел 
измерения

Разрешающая 
способность Макс. погрешность 

±     1 Volt 0.1 mV ± 0.5 %   ± 1.0 mV 

±   10 Volt 1 mV ± 0.5 %    ± 10 mV 

± 100 Volt 10 mV ± 0.5 %    ± 20 mV 
При одновременном замере по 3-м каналам, разность времени между  
каналами < 5 ms 
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5.3.2 Измерение напряжения переменного тока  (Канал A) 

Входное сопротивление :  > 10 MΩ 
 

Предел 
измерения 

Разрешающая 
способность Макс. погрешность 

  1 Volt eff. 0.1 mV ± 2.0 %      ± 1 mV 

10 Volt eff. 1 mV ± 2.0 %    ± 10 mV 

100 Volt eff. 10 mV ± 2.0 %    ± 50 mV 
Предел частот 10 Гц – 120 Гц, предельная частота 800 Гц (3 dB) 
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5.3.3 Измерение в микровольтах  (Канал A) 

Входное сопротивление:  > 1 MΩ 
 

Предел 
измерения

Разрешающая 
способность Макс. погрешность 

± 80000 µV 1 µV ± 0.2 %   ± 5 µV 
 
Уровень подавления помех по переменному напряжению: 
      16,6 Гц  /   60 dB     (Фактор 1.000) 
     50,0 Гц  / 100 dB     (Фактор 100.000) 
 
 

5.3.4 Измерение тока (Канал A) 

Предел 
измерения

Встроенный 
шунт

Разрешающая 
способность Макс. погрешность 

± 10 mA 10  Ω 1 µA ± 1.0 %     ± 5 µA 

± 100 mA 3  Ω 10 µA ± 1.0 %   ± 20 µA 
 
Уровень подавления помех по переменному напряжению: 
      16,6 Гц  /   60 dB     (Фактор 1.000) 
     50,0 Гц  / 100 dB     (Фактор 100.000) 
 
 

5.3.5 Измерение тока  (30 A токовый вход) 

Предел 
измерения

Встроенный 
шунт

Разрешающая 
способность Макс. погрешность 

± 30 A 0,01  Ω 1 mA ± 1.0 %    ± 3 mA 
 
Уровень подавления помех по переменному напряжению: 
      16,6 Гц  /   60 dB     (Фактор 1.000) 
     50,0 Гц  / 100 dB     (Фактор 100.000) 
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5.3.6 Измерение сопротивления 

Метод измерения :  Веннера, 2-полюсный или 4-полюсный 
 
Частота измерения :  128 Гц 
 
Выход. напряжение  :  max.   2 V эфф.  1 KΩ предел измерений 

   max. 10 V эфф.  10KΩ предел измерений 
   max. 10 V эфф. 800KΩ предел измерений 
 

 
Предел 

измерения 
Разрешающая 
способность 
(4-полюсный)

Макс. погрешность 

  1 K 
0.01 Ω 
0.1 Ω 

1 Ω 

0,0 Ω   -   9,9 Ω    ± 1.0 %   ± 0.05 Ω 
10,0 Ω - 199,9 Ω    ± 1.0 %   ± 0.50 Ω 
200 Ω    - 999 Ω    ± 1.0 %        ± 5 Ω 

10 K 10 Ω 
100 Ω  

0,00 KΩ  -  0,99 KΩ    ± 1.0 %    ±   50 Ω 
1,0 KΩ  -    9,9 KΩ    ± 1.0 %    ± 100 Ω 

 

800 K 
 

10 Ω 
100 Ω 
100 Ω 
1 KΩ 

 

0,00 KΩ  -    9,99 KΩ    ± 1.0 %   ± 0,1 KΩ 
10,0 KΩ  -    99,9 KΩ    ± 1.0 %   ± 0,5 KΩ 

100,0 KΩ  -  199,9 KΩ    ± 1.0 %   ± 1,0 
KΩ 

200,0 KΩ  -  799,9 KΩ    ± 1.0 %   ± 5,0 
KΩ 
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5.4 Маркировка клемм 

 
 

 

 
1 :  Клемма заряда земля GND 
 
2 :  Клемма заряда + 12 V 
 
 
3 :  GPS-питание земля GND 
 
4 :  GPS-питание + 5 V 
 
 
 
 
 
 

 

 

2 :  Контакт, свободный от 
      потенциала  
 
3 :  Контакт, свободный от 
      потенциала 
 
4 :  Внешняя синхронизация 
 
5 :  Внешняя синхронизация 
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